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Introduction 
 XRD2DScan is a Windows software tool for displaying and analyzing 

two-dimensional (2D) X-ray diffraction patterns collected using a 

diffractometer equipped with an area detector (CCD, image plante or X-ray 

film). XRD2DScan has many capabilities for generating different types of 

scans (2Theta scan, Psi scan, d-spacing versus Psi angle, Pole figures) which 

allows extracting the maximum information from the original 2D patterns 

(frames) about the mineral composition and microstructure characteristics 

(grain size, preferential orientation, crystallinity, etc.) of your samples. 

Additionally, the program can automatically analyze an unlimited number of 

frames using a batch processing mode. It initially supports different 

detector shapes (Flat or cylindrical - Guinier or Debye-Scherrer cameras) 

and data file formats, including Bruker (Multy-wire, SMART APEX, 

PROTEUM -.sfrm -), Oxford Diffraction (SAPPHIRE), Nonius, Rigaku 

RMax Rapid, ADSC, MarReseach (marccd), TIFF (uncompressed), 

bitmap (.BMP). Also, additional data formats can be adapted upon request.  

 This software is especially useful for systems initially designed for 

single crystal analyses and lacking software for analyzing diffraction 

patterns of polycrystalline materials. It actually allows the use of single-

crystal diffractometers such as advanced powder/material research 

diffractometers. 

Quick start guide 

Program installation 

Download the file XRD2DScanv411 Install.exe and run it. The 

program files will be saved at the „c:\Program Files\xrd2dscan4_11‟ folder 

and the data file examples will be saved at the „\DATA‟ subfolder. A 

shortcut „XRD2DScan4.1.1‟ will be created on your desktop. In case you 

have previously installed this program you may need to remove the previous 

version using Add/Remove Applications option of the Windows control 

panel. Example data files were measured using a Bruker single crystal 

diffractometer with a Smart Apex CDD detector and Mo K radiation. 

Example files are: Alumina.001, Aluminum foil.001, Aragonite.001, 

Calcite.001, Calcite.001, Halite.001, Magnetite.001, MolluskShell.001, 

SiC.001, LaB6.001. 
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Testing the program 

Click on the program shortcut and it will be executed. Once the 

program is launched, click on the Load file button  and select a data file 

example (i.e., Alumina.001). Double click on the file or click on Open and the 

alumina 2D pattern and the calculated 2theta scan will be displayed. Load 

more example files and they will be successively displayed. A small image of 

each frame loaded will be displayed in the history window. You can reload 

one of the visualized files by clicking on one of these images.  

Next click on the centering tools button  and click on Find center 

button. A new set of coordinates will be calculated and displayed at the 

logbook file. Also a recalculated 2theta scan with sharper peaks will be 

displayed. 

Then hold the A key pressed and click four times in the 2D pattern; 

first near the center (a blue cross will be displayed), second in the top left 

quadrant, third at the bottom left quadrant and fourth near the center 

again. You will have defined an angular sector delimited by blue lines as the 

one displayed in figure 1. A new 2Theta scan will be calculated, from pixels 

within the selected angular sector, and displayed. You can also select a 

rectangular sector by holding the S key pressed and clicking four times, 

one time in each one of the rectangle vertexes. You can also select these 

two types of sectors by using the Mask sector tool .  

You can analyze the 2theta scan very quickly as follows: 1) remove 

the background by pressing the remove background button . 2) find 

peaks by clicking on the Find peaks button . Peaks will be marked as blue 

circles and a list with the information of each peak will be displayed at the 

logbook. 3) Identify the pattern using the powder diffraction database 

implemented in the program . Click on the Find Match button, and a list 

of candidate substances will be displayed. 4) Save the generated 2theta 

scan to a file using the SaveToFile menu option .  

IMPORTANT: WHEN INSTALLING XRD2DScan software, please 

consider the following: The program can only be installed and works in an 

administrator type user account. You can change the type of account from 

limited to administrator type at Windows Control Panel (User accounts). If 

your computer has several hard drive units, the program could be installed 

instead of in the “C:\” drive in another one. Then you must move the 

directory “Program Files\XRD2DScan4_1” and its content to the C: drive and 

create a new short cut pointing to the executable file.  

If you experience problems installing the software, please report them to the author 
(Email: anava@ugr.es) 

If there are several user accounts defined on your computer, the program 

only works in administrator type user accounts. You can change the type of 

account from limited to administrator type at Windows Control Panel (User 

accounts). 
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Figure 1. Loading one of the example data files. 

 

Figure2. Frame of corundum (alpha-alumina) and calculated 2theta scan from the selected 

angular sector. 
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Figure 3. List of peaks found in the alumina pattern. 

 

Software description and use 

System requirements 

This program runs under Windows 98, 2000, XP (recommended) and 

Vista operating systems. It is recommended a resolution of the display of 

1280 x 800 pixels or at least 1024 x 768 pixels and an up-to-date computer 

(i.e. Pentium IV and 500 Mb RAM or higher).  

 

Main program window and logbook 

The typical interface of the program is shown in figure 1. Main 

components are the main window displaying the 2D pattern or frame, the 

Zoom window, the 2Theta scan window (at the top), the logbook and history 

window (at the bottom). The blue lines in the frame define the selected 

angle sector for intensity integration. By moving the mouse over the 2D 

pattern image, the pixel coordinates and their recorded intensities as well 

as the 2Theta and Psi angles are displayed in the Zoom tool window. At the 

bottom left, it is shown a logbook keeping record of the user actions. At 

the bottom center there is a history window displaying small images of 

frames which have been loaded in the past and can be reload by clicking on 

them. 

 

IMPORTANT: In order to get the correct 2theta angles in your 

diffractograms you need to change the default diffractometer settings 

(e.g. wavelength, detector size, sample to detector distance, etc.) to 

those specific of your diffractometer. You can do that in the 

Diffractometer menu option in the main menu. Do not forget to save 

these settings using the Diffractometer > Save settings option. 
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Figure. Main window of XRD2DScan software displaying a 2D diffraction pattern and the 

calculated 2Theta scan of a polycrystalline sample.   

 

Hereafter is described the main menu and its different options.  

Top 

Main menu 

 
 

File 
 Open 

 Load the data file(s) to be displayed and analyzed. In case several 

files are loaded, only the 2D patterns of the first and last files will be 

displayed. The 2Theta scans of all files will be displayed at the bottom. 

 

Save 

 Save the currently displayed frame. 

 

Edit 
CopyFrame 

 Copy the 2D pattern image to the Clipboard. Later you can paste this 

image to a word document or other programs. 

 

Tools bar 
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Under the main menu there is a tool bar with speed buttons for fast access 

to the main menu procedures. For instance, by clicking on the first button 

you can load a file to display. The second button (Mask sector) is used to 

select the angular or rectangular sector for further analyses (i.e. to 

calculate a 2Theta scan just using the pixels in the selected range). The 

third button (Delete sector) deletes all pixels within the angular sector 

defined. The 6th and 7th buttons are used to calculate a 2theta scan and 

Psi scan from pixels within the angular sector selected. The 9th button 

(Integrate sector) is used to integrate pixel intensities within the sector 

and to calculate the angular width of a peak within the sector. The next 

buttons are mathematical operations that can be carried out with the pixel 

intensities in the 2D frame. The following button is the pole figure analysis 

tool. The last two buttons are setup options of the main menu. The help 

button provides information about the use of hot keys for different 

actions. 

 

View 
Show Full Size Frame 

 It shows the full size of a frame in a new window. This option is 

useful for large frames measuring over 512 pixels in size (i.e. 1024 x 1024 

pixels) which otherwise are scaled and fitted into the 512 x 512 pixels 

display window.  This option helps to appreciate small details in the frame 

without the need to use the Zoom Window. To use it, select View > Show 

Full Size Frame menu option. 

 

Zoom Tool 

 It shows a zoomed detail of the frame at the current position of the 

cursor as it moves in the Frame window. To activate it, click on any point in 

the Frame Window. 

 

Frame Info 

 It shows the most relevant information about the current frame. 

This information includes: direct beam coordinates, wavelength, detector 

angle, distance to sample, detector size and filename. 
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Adjust Brightness 

 It allows to manually adjust the brightness of the frame to visualize 

it with more or less contrast and to avoid color saturation. 

 

Logbook 

 Displays the logbook which keeps a record of all information 

processed by the software.  

 

Top 
 

Math 
 It is possible to do several mathematical operations which can be 

useful for the analyses of 2D patterns. Hereafter are described the basic 

operations supported by the software.   
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AddFrames 

 You can add to the present 2D pattern the intensity of one or more 

data files. This is useful for integrating the information of several 

measurements of the same sample, so simulating for instance long 

exposures or rotation photographs. 

 

SubstractFrames 

 You can subtract from the present 2D pattern the intensity of a file 

for instance to remove the background intensity or the air scattering.   

 

MultiplybyConstant 

 This option allows to multiply the intensity of each pixel by a 

constant. 

 

AddConstant 

 This option allows to add a constant value to the intensity of each 

pixel. 

Top 
 

Select Area 
  It is possible to select a certain region of interest within the frame. 

This region or angular sector can be selected using the MaskSector tool. 
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 Define Sector 

 

 After the user has selected an angular range, this range is delimited 

by blue lines in the 2D pattern and as dotted blue lines in the 2Theta scan. 

The logbook also records the sector parameters as: 
Sector = 5.000, 0.000, 45.000, 360.000 

You can also directly select the angular range of the sector directly on the 

frame image. You need to click with the mouse (holding the A-key pressed 

for angular sector and S-key pressed for rectangular sector) four times on 

the image. The first click defines the minimum 2Theta, the second click 

defines the min Psi angle, and the third click defines the max Psi angle and 

maximum 2Theta. To test it, first click near the center (a blue cross will be 

displayed), second in the top left quadrant, third at the bottom left 

quadrant and fourth near the center again. You will have defined an angular 

sector delimited by blue lines as the one displayed in figure 1. A new 

2Theta scan will be calculated, from pixels within the selected angular 

sector, and displayed. In the case of a rectangular sector, you need to click 

on each of the 4 vertices of the rectangle while holding the S key pressed. 

Important: You must follow this sequence: first, click on the top left 

corner, then on the top right, then on the bottom right, and last on the 

bottom left corner. 

 

 Delete Sector 
 This option is to delete a part (that defined by Define sector option) 

of the frame. The selected area is shown in light blue and it is excluded 

from 2Theta scan calculation. This is useful to remove strong or undesired 

reflection spots.  
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 Select Active Area 
 This option is to crop or select a previously defined rectangular 

sector as the active area, and discard the rest. After this action, the 

frame is scaled to fill the frame window. This option is quite convenient 

when working with scanned films containing background or not useful 

regions.  

Eraser tool 
 It allows deleting specific unwanted pixels which ought not be 

considered when calculating 2theta or Psi scans. To delete pixels, hold the 

key D pressed and click with the mouse on the pixels you want to remove. 

The size of the eraser can be changed by the menu option Select area > 

Erase tool. This option is useful to remove strong single-crystal reflections 

spots or bad pixels. Erased pixels are shown in light blue and are excluded 

when calculating a 2theta scan. 

 

 

Masking Tools: 
 

Mask pixels above a value  
 It deletes pixels with intensities above a user defined value. It 

allows to mask strong reflections.   
 

Mask pixels below a value  
 It deletes pixels with intensities below a user defined value. It 

allows to mask background pixels.   
 

 Find and Mask single crystal reflection spots 
 It finds automatically single crystals spots within the frame. After 

finding them, the associated pixels are masked and are no longer 

considered when calculating a 2Theta scan. This option is useful to remove 

strong single-crystal reflections spots. This option is useful to mask single 

crystal reflections superimposed to powder rings, for instance when using a 

diamond anvil for high pressure research. It is also useful to remove strong 

reflections from coarser grains and avoid their contribution to the 

calculated 2Theta scan. The size of the windows to mask reflections and 
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their minimum intensities can be set by the user. To see how this option 

works see example below. 

 

 

Single crystal spots superimposed to powder rings of two different compounds. In the 

calculated 2theta scan, there are peaks associated with single spots and others with the 

rings.  

 

After masking the single crystals spots using the Find and Mask tool, one peaks 

associated with powder rings are displayed in the calculated 2Theta scan. 

Save Mask  
 It saves to a file (*.msk) the deleted pixels (i.e., with the Delete 

sector or Eraser Tool) of a frame. It allows to save masked or deleted 

regions within a frame. They are also applied later in other frames. This 

procedure is useful to mask strong reflections in consecutive measured 

frames, for instance when using a diamond anvil for high pressure research.   

Load Mask  
 It loads a previously defined mask with the deleted pixels at specific 

x, y coordinates. Masked pixels are displayed in light blue color and are not 

considered when calculating a 2theta scan. The same mask file can be 
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loaded in successive files by selecting this option in the Scan Settings 

windows.  

 

 

 IntegrateSector and CalFWHM 

 Integrates the intensity of all pixels within the angular sector 

defined by MaskSector and reports the result in the logbook. It also 

calculates the angular width at half maximum intensity (FWHM) of the 

sector in 2Theta and Psi angles. This information could be useful for 

analyzing a single peak or band in the frame. Example: After integrating a 

sector the following results are displayed in the logbook:  

Sector = 24.820, 318.502, 26.870, 329.317 

Integral = 258771;  MaxIntensity = 9077.0;  Number of pixels in sector = 1045 

2ThetaMax =25.785;  FWHM2Theta = 0.563 

34444 pixels contributing to the Psi scan 

PsiMax =318.750;  FWHMPsi = 3.259 
 

Integrate sector slices 
 It integrates the intensity of all pixels within the 2Theta angular 

range defined by MaskSector in slices of Psi angular width defined by the 

user (1, 2.5, 5, 10, 20 deg.). It reports the results in the logbook and saves 

it to an output file (Experiment name.slc) if this option is selected in batch 

processing. It can be automatized using batch processing when analyzing 

more than one file. Integration of sector slices could be useful for 

determining pole figures from 2D diffraction patterns. For every 2D 

pattern a cut of the pole figure at constant Phi is obtained. 

 

Analisis tools 

 

 Remove Frame Background 

 This menu option removes the background of the 2D Frame. It 

defines the background as the local minima around pixels within a window of 

size defined by the user. This option can be selected automatically using 

the Experiment Settings menu by checking the 2D Frame option of Remove 

Background. The size of the window can be defined in the Scan settings in 

the windows size input box. 

Note: To visualize the background of a Frame do the following: a) Remove 

the background of the frame, b) substract the original frame to the 

resulting frame using the substract frame option of the Math menu c) 

Multiply the resulting frame by -1  using the Math menu option, multiply by 

a constant. 
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 Smooth Frame 

 It applies a Gaussian filter to remove noise data in the frame image. 

The user can define the size of the window for the Gaussian filter.  

 

2Theta Scan Sector 
 

 Calculates and displays the 2Theta scan generated by using pixels 

within a Psi angular range defined using MaskSector. You can select this 

range by adding the lower and higher values of Psi angles. 2Theta values 

would just define the displayed range. The program finds pixels within the 

Psi range for every 2ThetaStep. 2ThetaStep defines the resolution of the 

2Theta scan and can be changed in the Scan Settings  of the main 

menu. If you increase this value, the profile is smoother whilst the profile 

becomes more noisy if this value is decreased. Be careful not to set a value 

too small or you will be oversampling and you will get a very noisy profile.  

 

 
 

 

Figure. 2Theta Scan of a LaB6 powder sample. At the top chart, the zoomed section of the 

scan is shown. At the bottom chart, the whole scan is shown. 

NOTE: The intensity profile is calculated by radially integrating pixel 

intensities. To be able to compare these data with the data collected 

using a standard powder diffractometer with a point detector, the 

intensity for every step is averaged by the number of pixels contributing 

to it. Otherwise the intensities will increase with the 2Theta angle or 

with the perimeter of the rings.  
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Analyze 

 Background 

 Remove the background of the intensity profile using a ball 

algorithm. Basically, an elliptical ball is defined by an angular width (needs 

to be at least the peak width) and an intensity height, that press (? fits) 

under the intensity profile to calculate the background profile. If you are 

not satisfied with the background removal you can click on UndoBackground 

to restore the original profile. The calculated background can be viewed 

using View menu. You need to select UndoBackground option to recover the 

original profile. 
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 FindPeaks 

 Calculate the position, intensities and angular width of peaks in the 

2Theta scan. Before you may need to remove the background using the 

Analyze (Background) option. Peaks are marked as blue open circles. Peak 

information is reported in the logbook as follow: 

Sector = 0.000, 0.000, 35.000, 360.000 

Peak list 

Peak#       2Theta     d-spacing    PeakIntensity   PeakArea 

1    12.198    3.345     77    1807 

2    13.742    2.970     130    2642 

3    16.161    2.528     437    6823 

4    19.507    2.098     106    2191 

5    23.933    1.714     88    2079 

6    25.375    1.618     138    2689 

7    27.588    1.490     197    3569 

8    32.323    1.277     62    1744 

…. 

… 

 
 

 FindPeaks menu option. 

 

 Pattern Search Tool and Mineral Powder Diffraction Database 

 

 XRD2DScan includes a database with diffraction patterns of a 

selection of common chemicals and minerals.  This database can be used to 

identify minerals and to correct peaks shift (in 2Theta angles). This 

information is used to refine experimental parameters such as sample-to-

detector distance or detector size (see Correct2theta). 

NOTE: For more advance options use the menu option Analyze > 

FindPeaks. Using this option it is possible to define the search 

parameters (peak width, minimum intensity, etc.) and for instance 

restrict the search of peaks to the selected angular range. Thus it is 

possible to measure the main peak of a mineral phase in a series of 

frames.  
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Upgrading the database 

 

You can add a new record using the Add button of Mineral List tool and fill 

in the information of the new phase with its name, formula and d-spacing, 

instensity and hkl of characteristics reflections. To save the record press 

the Save button.  

 
 

Additionally, you can load a record directly from an ASCII text file using 

the Load button. The first line is the mineral name, the second line is the 

formula, the third and successive lines contain the d-spacing, percent 

intensity and hkl. See example below: 
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Searching mineral phases within the database 

You can search for different mineral phases having a certain name, atom or 

molecular groups using the Boolean Search Tool. It is case sensitive. 

 

 
 

 
 

Comparing experimental patterns with patterns from the database 

 

You can easily compare experimental patterns of a mineral with those of 

the database just by clicking on one of the minerals of the list. 

Example: You can visualize only hydroxide minerals using the Boolean 

Search. 1) Type OH in the Include cell and Si in the Exclude cell (to 

exclude silicates with OH groups). 2) Select Formula. 3) Click on Apply 

button. 
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Figure. Compare mineral pattern from the database (i.e. calcite) with an 

experimentally measured pattern.  

Automatic mineral identification using the Search Pattern tool 

You can identify the minerals in a sample using the Search Pattern tool. 

Click on Find match, and a list of possible records matching the measured 

sample will be displayed. You can restrict the search by applying some more 

restrictions using the Boolean Search tool or increasing the Search 

constrains level. 

Correct2Theta 

 

In case the position of peaks in the 2Theta scan are shifted from 

the theoretical values, it is possible to correct the angular shift by using 
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the Correct2Theta option. There are three possibilities for this correction 

to be made: 

1) Type the actual peak position (2Theta angle) in the 2Theta measured 

text box and type the correct or expected value in the 2Theta correct 

text box. Click on the Adjust 2ThetaAngle radio button. Then click OK and 

the whole pattern will be shifted by the offset angle.  

2) Type the actual and correct 2Theta positions for a peak and click on the 

DistanceToSample radio button. Then click on the OK button. A message 

will be displayed saying that the distance from the sample to the detector 

has been changed to adjust the peak position. 

3) Type the actual and correct 2Theta positions for a peak and click on the 

DetectorSize radio button. Then click on the OK button. A message will be 

displayed saying that the detector size has been changed to adjust the 

peak position.   

 

 

 Zoom 

 To enlarge a region of interest in the diagram you can hold the Z-key 

pressed down and click with the mouse at either size of the region of 

interest. Then the region will be zoomed. To zoom out select the Zoom Out 

option of the menu. 

 

ShowBackground 

 After removing the background of the intensity profile, the 

background can be visualized with this option. If you want to go back to the 

original background you need to select the UndoBackground option of 

Analyze. 

 

ViewIntegrate 

If selected the integrated range is shown for each peak (in blue) 

after selecting the FindPeaks option. 

IMPORTANT: To correct the angular shift it is better to use a 

standard and the Fit parameter tool (see next sections and appendix 

5). To make these changes permanent you should click on Save Settings 

under the Diffractometer menu. The new values will be saved to 

Settings.txt file. 
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File 

 SaveAs 

 You can save the 2Theta scan as an ASCII file to further process 

the data with other software. The output file format is as follow: 

1st line: blanck or with text comment 

2nd line: initial 2theta angle. 

3rd line: 2theta step size. 

4th line: wavelength used (i.e., 1.5405 for copper). 

5th line1: DATA 

6th line and after: 2Theta angle  intensity counts. 

Example:  
"comments on sample " 

5 

.02 

1.54051 

DATA 

0.100   174.000 

0.200  153.000 

::: 

When saving the data you can select other output data formats (three 

columns: including d-spacing data or just one column with intensity data).  
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 X- and Y-line scans 
 Calculates and displays the intensity profile along a line in the 2D 

frame at a constant value of x or y coordinates of the diffraction image. By 

pressing the arrows keys, it is possible to scan the intensity profile for 

different values of x or y along the image.  Using associated tools 

( ), it is possible to determine or refine the values of important 

experimental parameters such as distance to detector, direct beam 

coordinates and lambda (see appendix 5 about how to calculate them).  

 

X line scan of the example file (Calcite.001) at a constant value of Y=243. 

 

 Psi Scan of Sector 
 Calculates and displays the Psi scan of a given 2Theta angular range. 

Before generating PsiSectorScan you need to define the range of 2Theta 

values contributing to the Psi scan using the MaskSector (for instance the 

2Theta values before and after a Bragg peak). You can enter these values 

in the MaskSector or by holding the A-key down and clicking with the 

mouse in the 2Theta scan under the 2D pattern at either side of the Bragg 

peak of interest. Another important parameter is PsiStep that can be set 

at the Scan Settings of the main menu. This value defines the resolution of 

the Psi scan. If you increase this value, the profile is smoother while the 

profile becomes more noisy if this value is decreased. Be careful not to set 

this value too small or you will be oversampling and you will get a very noisy 

profile. 
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Figure. Sector defined between 2theta = 21.188 and 22.688; and Psi=120 to 230 

 

 

Figure. Calculated Psi scan for a sector from 2Theta = 21.188 to 22.688. The 

detected peaks using the FindPeaks option are marked with blue circles. 

 

Hereafter are described some capabilities for analyzing the Psi scan using 

the different options of the Analyze menu.  
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Analyze 

 Background 

 Removes the background of the intensity profile using a ball 

algorithm. Basically, an elliptical ball is defined by an angular width (needs 

to be at least the peak width) and an intensity height that fits (press ?) 

under the intensity profile to calculate the background profile. If you are 

not satisfied with background removal you can click on UndoBackground to 

restore the original profile. The calculated background can be viewed using 

View menu.  
 

 FindPeaks 

 Calculates the position, intensities and angular width of peaks in the 

Psi scan. Peaks are marked by a blue open circle and in blue if 

ViewIntegrate is selected. Before performing this operation you may need 

to remove the background using the Analyze (Background) option. Peak 

information is reported in the logbook as follow: 

Peak list in DebyeRing 

2theta range from 21.188 to 22.688 

Peak#       Psi    Peak_Intensity   Peak_Area 

1    129.500     5341    19248 

2    130.250     7678    33086 

3    132.000     9372    28685 

4    133.750     2522    6424 

5    138.250     4567    18467 

…… 

…… 

Peak numbers and intensities of spotty ring can be used to determine the 

size of crystals in the sample (see references). 

 

 
Measuring peak intensities and angular widths of individual peaks 
 

 This information is useful for instance to quantify the degree of 

preferential orientations of a polycrystalline sample by measuring the 

angular width of the broadest peak or band displayed in the Psi scan. You 

can measure the width by holding pressed the A-key and clicking with the 

mouse at either side of the peak region. The results are displayed in the 

IMPORTANT: In case you have a noisy pattern you may need to smooth 

the pattern. This can be achieved either by selecting a greater Psi 

angular range for integration using MaskSector or by increasing the 

PsiStep size at the Scan Settings  (do not forget to click on set after 

changing the step size value). The last option may increase the width of 

peaks.  
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logbook with the angular width at as full width at half maximum (FWHM). 

See the example below of a calcitic mollusk shell displaying a strong 

preferential orientation of the c-axes perpendicular to the shell surface. 

 

Figure. Diffraction pattern of a mollusk shell measured by reflection.  

 

Figure. Psi scan from sector displayed in the 2D pattern (see above) of a mollusk 

shell.  
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Typical output in the logbook is: 
Sector = 28.040, 120.000, 29.279, 230.000 

peak at 179.000 IntMax = 139,528 Area = 2,557,064 FWHM = 18.327 PsiL-PsiR = 

61.389 

Other useful features 

 Zoom 

 To enlarge a region of interest in the diagram you can hold the Z-key 

pressed down and click with the mouse at either size of the region of 

interest. Then the region will be displayed at the top graph in the Psi scan 

window. To zoom out, select the ZoomOut option of the Zoom menu. 
 

View 

  ShowBackground 

 After removing the background of the intensity profile, the 

background can be visualized with this option. If you want to go back to the 

original background you need to select the UndoBackground option of 

Analyze. 
 

ViewIntegrate 

  If selected the integration range for each peak is shown in blue 

after selecting the FindPeaks option. 
 

File 

 SaveAs 

 You can save the Psi scan as an ASCII file to further process the 

data with another software. 

Top 
 

d-spacing as a function of Psi angle 

 Calculates and displays the values of d (in Ångström) as a function of 

Psi angle for a given Debye ring. Before generating a d-spacing plot you 

need to define the range of 2Theta values delimiting the Debye ring by 

using the MaskSector option (for instance the 2Theta values before and 

after a Bragg peak). You can enter these values directly in the MaskSector 

or by holding pressed the A-key and clicking with the mouse in the 2Theta 

scan under the 2D pattern. The d-spacing is calculated by dividing the 2D 

pattern in sectors of 5 degrees (of Psi angle) and finding the 2Theta angle 

that provides maximum peak intensity in the 2Theta range of interest. 
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Batch processing of data files 

A very useful and important feature of this software is that you can 

either analyze the data files one by one interactively or multiple files 

automatically using batch processing. Batch processing is convenient for 

analyzing many data files with minimum user intervention. 

 

 New Batch Project 

 This menu option defines the working environment for a new project 

to analyze a set of data files automatically. A project name and a working 

directory need to be defined. The project name is used as part of the name 

of the output files generated by the batch project. The working directory 

is the directory of data files to be analyzed. The Output Directory is the 

destination directory for output files generated by the batch process.  
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 Depending on the information you want to generate from each 

data file loaded, you can select different options of batch processing 

(Calculate and Save Data to File). If you just need the calculated 

2Theta scan of a predefined angular sector for each loaded data file, 

you can check 2Theta Scan (for each data file an ASCII file with „.THS‟ 

or „.PLV‟ extension is generated, depending on the selected output file 

format). If you need the calculated Psi scan of a predefined angular 

sector, check Psi Scan (an ASCII file with „.PSS‟ extension will be 

generated). If you need the variation of d-spacing with the Psi angle 

along a Debye ring defined by the selected angular sector, check the d-

spacing option (an ASCII file with „.DSP‟ extension is generated). For 

finding the peaks in a 2Theta scan, check the Peaks list in the 2theta 

scan option (an ASCII file with „.TPK‟ extension is generated). For 

finding the peaks in a Psi scan, check the Peaks list in the Psi Scan 

option (an ASCII file with „.PPK‟ extension is generated). If you mark 

the Peaks in the Psi Scan summary option, an ASCII file with the 

experiment name + „.PSS‟ will be generated. This file contains a summary 

of the number of peaks and their intensities in Psi scans for each 

processed data file.  

 

 Scan settings 

In scan settings, it is possible to define several corrections for the 

scans and also to change the resolution or step size when calculating the 

2Theta and Psi scans. It is also possible to define some parameters that 

are necessary for the automatic background subtraction and peak 

finding tools. This option is specially indicated when doing batch 

processing of files. The same parameters can be set interactively when 

subtracting the background or finding peaks in a given diffractogram by 

using the appropriate menu options. Note that depending on the pixel 

positions on the detector, a different solid angle of diffracted X-rays is 

collected. To correct the intensities for the flat detector shape, you 

need to set the geometrical correction check box. Also check the Apply 

Mask file box to apply a previously loaded mask file to successive data 

files. 
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Changing the resolution of 2Theta and Psi scans 

The software automatically calculates the resolution of the scans 

considering the detector size, resolution and distance to the sample. You 

can set the resolution of 2Theta scan and Psi scan to a value of your 

convenience by changing the 2ThetaStep and the PsiStep, respectively at 

the scan setting menu. To apply these values, you need to click on set 

(otherwise the software will use the default values for these properties) 

and click on the APPLY button. Note that if you set a value too small, you 

would be oversampling and will produce a very noisy pattern (see bellow for 

an example).  

 

 

Noisy 2Theta scan due to oversampling. 2theta step size was 0.05 degrees.  

IMPORTANT: The software calculates automatically the size of angular 

steps. You may need to change these parameters to avoid oversampling or 

to homogenize the sampling rate for different patterns recorded using 

different settings (i.e., detector size), for instance to add or subtract 

one line scan to another, etc.  
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Smooth 2Theta scan without oversampling. 2theta step size 0.1 degrees. 

 

Diffractometer Settings 
 In order to process correctly the data files, a set of experimental 

parameters specific to the diffractometer used to collect the 2D patterns 

needs to be known (i.e. X-ray wavelength, detector shape – flat or curved -, 

detector size, distance from sample to detector, etc.). In case these 

parameters are not defined in the data file (i.e. in TIFF files) or you 

suspect they are incorrect, you can set them manually using the different 

menu options under Diffractometer. In case you want to continue using 

these parameters you need to click on the Diffractometer > Save Settings 

option and save the new settings to a file. You can define several settings 

files for different diffractometers and load them afterwards using the 

Diffractometer > Load Settings option. The default configuration is that of 

a Bruker Smart Apex diffractometer with a flat detector defined in the 

SmartApex.set file. 
 

 Setting or finding a new pattern center 
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Defining the correct position of the direct beam or pattern center is 

critical for the analysis of 2D patterns (i.e. generation of 2Theta and Psi 

scans). When opening a data file the center information is loaded. In case 

you suspect that this center is not correct, you can set a different one 

using one of the six centering methods defined at Find Center Tools in the 

setup menu.  

1) Manually: Type the new Xo and Yo coordinates and press the Set 

button.  

2) Automatically: Select the Auto option and click on the FindCenter 

button. It automatically finds the pattern center that provides the 

sharpest peaks. It is the easiest and best option. 

3) GravityCenter: Select GravityCenter and click on FindCenter button 

after that. The program calculates the center of gravity of all pixels. 

Caution: This option should only be used when the 2Theta swing angle 

of the detector is set at zero (direct beam hitting the detector 

center). If the Detector is set at a different angle, other centering 

tools should be used.  

4) SectorCenter: It searches the center of a sector in the frame (i.e. a 

Debye ring) defined by the MaskSector tool. It functions 

automatically in a similar way as EllipseCenter. You just need to 

select this option and click on the FindCenter button. 

5) EllipseCenter: select this option and click on different points of a 

Debye ring of the 2D pattern. Each time a blue dot will appear on the 

Frame pattern. When finished, click on the FindCenter button. A new 

set of Xo and Yo coordinates will be displayed. 

6) Directbeam: select this option if the direct beam is visible. It find 

the center as that of pixels with the maximum intensity. 

 
 To see the effect of the pattern center on a real sample look at the 

2Theta scans of -alumina calculated using the diffractometer beam 

coordinates and those found by the program. The sample was measured 

using Mo K and a SMART APEX single crystal diffractometer (Bruker, 

Germany). An alternative way to determine the direct beam coordinates 

or center is by using a standard (see appendix 5). 

IMPORTANT: After finding a new center, the 2Theta scan will be 

recalculated. If you are satisfied with the scan that is generated with 

the new coordinates you need go to Detector settings and to click 

on Apply all besides Xo and Yo on the pattern center settings for this 

coordinates to be used afterward or when opening new files.  
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Figure. 2Theta scan calculated using the beam coordinates (254.449, 256.541) 

defined by the diffractometer.  Peak widths range from 0.551- 0.643 degrees. 

 

Figure. 2Theta scan calculated using the beam coordinates (255.325, 254.652) 

defined automatically by the program. The peaks are better resolved and peaks 

are much sharper. Peak widths range from 0.465-0.553 degrees. 
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Detector settings 
 Using the detector settings window, you can set most relevant parameters. 

 

Wavelength 
 This menu option defines the wavelength of the X-ray radiation used 

in your experiments. After having defined the value, press OK. To Apply 

this value in other files loaded afterwards, you need to select the Apply all 

option. To determine an unknown wavelength when using a standard see 

appendix 5. 

 

Angles 
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 You can defined manually two important angles of the 

diffractometer. One is the detector swing angle (2Theta angle) and the 

another is the tilting of the Phi rotation axis. The latter angle is important 

when calculating pole figures from a set of 2D patterns (see Annex at the 

end of this manual). 

Distance to detector 

For the correct calculation of 2Theta scans, the distance to the 

detector and the detector size need to be defined. Otherwise, the 

calculated values of the 2theta angle in the scans will not be correct. 

Before changing the Detector size or Distance to sample, refine these 

parameters by using a powder sample of a standard for which the 

2theta angles of the main reflections are well known (i.e. corundum). The 

corrected distance to the detector or the detector size can be 

determined using the correct 2Theta option in the Analyze menu of a 

2Theta Scan.  You can as well input its value directly in the appropriate 

text box and click on Set (otherwise the software will use the original 

values in the data file). An additional way to determine the distance to 

the detector is using a standard (see appendix 5). 
 

Detector Shape 

  

 The new versions (3.0 and later) supports different detector shapes: 

Flat or curved or spherical detector with a geometry of Debye-Scherrer or 

Guinier cameras.  

 In the case of a cylindrical detector you need to define several 

parameters that are: radius of camera, detector length and height or 

alternatively the pixel size. 

 

Detector size 
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For SMART APEX I, the detector size needs to be set at 61.00 mm  

To make this change permanent click on the Diffractometer > Save settings 

option and this value will be saved to the file Settings.txt. 

Model and user info 
 It is also useful for future reference to input the information about 

the diffractometer you used to collect the samples as this information is 

stored in the output data files. 

 

 
 

Save settings 

 To make changes permanently click on the Diffractometer > Save 

setting menu option. A message indicating that the new settings have been 

save should be displayed. 

 

Top 
 

License 

 The demo version of this program is limited to the sample files. In 

order to analyze your own samples and get full advantage of the capabilities 

of the software you need to get a valid license. To get a license you need to 

send us the evaluation code displayed at the top bar of the program. Below 

it is displayed the interface of a DEMO version showing an Evaluation code 

of 655E-CECE-6BE7-6D56.  
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After inserting the license activation key the following message is 

displayed: 

 

For additional information contact the author at E-mail: 

anava@ugr.es 

mailto:anava@ugr.es
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 Appendix 1: Hot keys 
  

 There is a short list of hot keys in the help option of the main menu. 

They are used in the program for fast access to some frequent actions 

such as the selection of a new center, an angular sector for integration, to 

delete unwanted pixels, to zoom in the scans or to mark a ring at a specific 

2theta angle.  

 
 

 Appendix 2: How to register and generate pole 

figures 

The orientation of crystals in a polycrystalline sample is adequately 

described using pole figures which displaying the 3-D distribution of 

specific crystallographic directions or poles. Pole figures can be registered 

more efficiently using diffractometers equipped with an area detector 

than with conventional texture diffractometers equipped with a point 

detector. Basically, a series of Frames need to be collected while rotating 
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the sample around the phi axis using a reflection setting. A 180 or 360 

(better) deg rotation is needed to explore all possible sample orientations. 

That means a total of 36 or 72 frames needs to be collected, each one 

after rotating the sample around the phi axis by a 5 degrees step. The 

registered frames files need to be saved using the same filename but 

different and consecutive numerical extensions (i.e. from frame.000 to 

frame.035 or frame.071 for a full rotation). 

Once the series of frames has been registered, the pole figure of a 

given crystallographic direction can be generated by analyzing the variation 

of intensity of its associated reflection at different sample orientations. 

This can be achieved automatically by using XRD2DScan software following 

these steps: 

1) Load one of the frames of the collected series. 

2) Select a 2theta range of the reflection to be measured using the 

MaskSector tool or clicking with the mouse while holding the A-key 

pressed. 

3) Open the Pole generation and analysis tool .  

 

Figure. Graphic interface of the PoleFigure tool displaying four pole figures of a 

mollusk shell showing a fibre texture. Below there are two plots displaying the 

variation of the intensity profile with Psi and Phi angles. 

 

4) Click in the Make New Pole figure option . The following interface 

should be displayed. 
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Figure. Interface of the Pole figure generator. 

 

5) Select the 36 (half rotation) or 72 (full rotation) measured frames all at 

once by using the Select Frames button.  

6) Write a file name and click on Generate button. After processing and 

extracting the information from the 36 or 72 frames, a pole figure will be 

displayed. The pole figure is saved to filename + „.scl‟. 

7) To displays the pole figures go to the Pole figure tool Main interface. 

Define the Psi titlting angle of the Phi rotation axis on Settings. In the 

case of a Bruker SMART APEX, they have the Phi axis at a constant Chi 

angle of 54.7 degrees. We use the equivalent Psi angle that needs to be set 

at the program and that is 144.7 degrees.  

Once this angle is defined, you can display the pole figures just by opening 

the .scl files. Up to 4 pole figures can be plotted simultaneously. The 

XRD2DScan evaluation program comes with three .slc files (pole006calcite, 

pole104calcite, pole108calcite) for test. 

8) You can do some basic analyses of the pole figures such as: a) display the 

intensity profile at a Phi or Psi constant (Psi or Phi scans) just by clicking on 

any point of a pole figure. b) calculate the width of the bands in these 

profiles to quantify the scattering in the orientation of crystals. c) 

calculate the interfacial angle between any two points in the pole figures. d) 

correct the pole figures for the absorption effect. e) rotate the pole 

figures around the phi angle.  

In case you need to do some more sophisticated analyses such as calculating 

the orientation distribution function (ODF), you can convert .scl pole 

figures to popLA format (.epf) and process the pole figures with popLA 

software. 
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Appendix 3: Measuring the grain size of mineral 

samples 

 (Average) crystal sizes can be calculated from peak intensities of 

spotty diffraction rings produced by a polycrystalline sample. Such 

patterns are collected using a small X-ray beam (i.e., 0.5 mm) and an area 

detector which is often available in modern single crystal diffractometers. 

Peak intensities can be automatically measured using XRD2DScan software. 

Crystal sizes can be determined from peak intensities after calibration 

using samples of the same material whose sizes are already known. This 

technique is independent of the aggregate state of the material. Also, 

crystal sizes of different mineral phases present in a sample can be 

analyzed independently. 

 
The figure above displays the variation of intensity along a Debye–Scherrer 

ring associated with a silicon carbide 220 reflection as a function of ψ 

angle for different powder samples with average sizes of 9, 7 and 5 μm. 

The ψ scans were calculated by integrating pixel intensities within the 2-θ 

range, from 26.229 to 26.939 degrees. Intensity profiles consist of a 

series of peaks of similar intensities. Each peak within a ring corresponds 

to the reflection of an individual crystal oriented with its (220) planes in 

diffraction condition. Peak intensities increase on average as crystal size 

increases, while the number of peaks decreases. From the intensity of the 

reflection spots, and by using a calibration curve such as the one depicted 
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in the inset, relating average intensity of peaks and crystal size, the 

physical crystal size can be determined in the micron range. 

 

Appendix 4: Sample preparation and mounting 

 In order to analyze powder samples, they first need to be 

consolidated using a small amount of glue or resin to form a free-standing 

thin sheet or rod which can be easily handled and mounted on the 

goniometer head. Alternatively, we can impregnate a fiber used for 

mounting single crystals with glue and dip it into the powder sample to 

collect just enough material to be analyzed. For solid consolidated samples, 

we just need to cut a small piece and place it on a holder for reflection 

setting with the surface to be analyzed perpendicular to the φ rotation 

axis as show in the figure below. Then the goniometer head screws are 

adjusted to bring the sample surface into focus and with the region of 

interest in the centre of the crosshairs of the video window. Then the 

sample is rotated around the φ axis to check if the region of interest stays 

in focus. Otherwise the sample position needs to be adjusted again. 

  
Experimental set up to measure a sample by reflection. 

 

Appendix 5: How to calculate experimental 

parameters using a standard 

You can calculate or refine the values of main experimental parameters 

(beam coordinates, distance to detector, detector size, ...) using the Fit 

tool 
1) Load a sample file : Calcite.001 
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2) Adjust the brightness and image size using the zoom buttons. 

 
 

3) Select full range using the  button in the 2theta scan windows menu. 

4) Select the calcite std from the mineral database 

5) Select an angular range contaning the main calcite peaks : i.e. 10 to 25 deg. 

 
There are some notable shift in the peak position from the calcite std 

lines. 

 

6) Correct std line shift manually using the top left or right arrow, expand or 

contract buttons so that the std lines move to be coincident with peaks 

displayed in the 2theta scan. 

 
 

7)  

Now we can find the value of setting parameters with produce the best fit 

of peaks with std lines in the selected angular range (peaks out of this range 

are ignored). To do that press the Fit button .  Then select the parameters 

to optimise (i.e., center of pattern xo, yo and distance) by checking the 

associated boxes. Check also the peak width and background values.  Then 
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press Start button and the parameters that produced the best fit would be 

calculated. To apply them press Apply button and a new 2theta scan with 

sharper peaks will be calculated which fit optimally the peaks to the std lines. 

You can repeat this procedure several times to improve the results if 

necessary. The quality of fit is quantified by the residuals (in degrees per 

point) displayed in the logbook. The smaller the better. 

 
 

You can save these settings to a new file and load it to use it latter for 

other samples measured in the same condition. 

Fitting parameters using X and Y line scans.  

It is possible to determine or refine the values of a single experimental 

parameters such as distance to detector, direct beam coordinates, 

detector angles and wavelength using X- or Y- lines scans and associated 

tools ( ). Using the sample file Calcite.001 and the Calcite 

standard from the mineral database we need to do the following steps: 

1) Load the sample file Calcite.001 by pressing the  open file button. 

2) Press on the  X- line scan button. 

3) Press on the mineral database button  and click on Calcite in the 

mineral list. The calcite std lines will be superimposed on the Y line 

scan. 
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X line scan of the example file (Calcite.001) at a constant value of Y = 243 with 

the Calcite lines. 

 

4) Move the mouse over the main line of the Calcite standard in the Y 

line scan window. While holding the left button pressed, drag the 

main line of the Std pattern to the strongest peak displayed in the 

line scan. 

 
 

5) Move the mouse over the Std lines displayed around 200 pixels. 

While holding the right button pressed, drag the lines of the std 

pattern to the fourth peak displayed in the line scan of Calcite 

sample. 
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6) Press on the Dis or lambda buttons in order to calculate the values of 

distance to detector and X beam coordinates or the wavelength. A message 

dialog like the one above should be displayed. If you are satisfied with the 

new calculated values, press the Yes button and a 2theta scan considering 

these new values will be displayed. The recalculated 2theta scan should 

show better matching with calcite std lines. 
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Recalculated 2theta scan considering the new distance to detector and X beam 

coordinates and the superimposed calcite std lines. 

 

7) It is possible to match automatically the Std lines to their nearest peaks 

in the X-line scan using the find local maxima button ( ). There are two 

important things to consider. 1) You should select a pixel range on the line 

scan to apply these changes. To do so, click with the mouse (while holding 

the A or Z key pressed) in the line scan window at the beginning and end of 

this range. The selection of this range is important as the later 

adjustments and calculations will be restricted to this range. Then press 

the AF button one or several times until the std lines coincide with their 

nearest peak maxima. 2) Avoid doing this auto adjustment in regions in 

which there are several Std lines near each other and close to one peak. In 

the latter case, the two lines positions would be merged into the same peak. 

You can avoid this problem by alternatively selecting different ranges, 

finding the local maxima and zooming out. 

 

 
 

IMPORTANT: The value of calculated parameters is interdependent so 

it is important to know with confidence the rest of parameters when 

calculating another. For instance, it is necessary to know the wavelength 

in order to calculate the distance to the detector, etc. 
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